
© Huntron, Inc 20 12  Rev. 5 1 

Huntron Workstation Tutorial  

HUNTRON WORKSTATION TUTORIAL ................................................................ 1 

HUNTRON WORKSTATION SOFTWARE TUTORIAL .......................................... 3 
Huntron Workstation software  3 

Installation Instru ctions  3 

Huntron Workstation Main Interface  4 

The Toolbar  5 

Hardware Setup  5 

Using a ProTrack  7 

Using a Tr acker Model 30  9 

Manual Modes ï Tracker and Scanner  9 

Creating a Board Test  10  

Test Building Procedures  11  

Creating a Board Database  11  

Adding a New Sequence  12  

Component Package Types  13  

Adding a New Component  14  

Adding a New Range  15  

Prober  Setup ï Camera Offset part 1  19  

Prober Setup ï Camera Offset part 2  20  

Camera Offset for Access DH  21  

Alignment for Access DH  23  

Prober  setup ï Alignment part 1  24  

Prober setup ï Alignment part 2  25  

Creating a Board Image  26  

Prober setup ï Component Teach; step 1 (DIP package example)  27  

Prober setup ï Component Teach; step 2 (DIP package example)  28  

Prober setup ï Component Teach; step 3 (DIP package example)  29  

Prober setup ï Component Teach; step 4 (DIP packag e example)  30  

Prober Setup ï Component Teach with Access DH  30  

Prober setup ï Component Teach Height; step 1  34  



© Huntron, Inc 20 12  Rev. 5 2 

Prober setup ï Component Teach Height; step 2  35  

Teach Height for Access DH  36  

Manual Modes ï Camera and Prober  38  

Scanning a Sequence or Component  39  

Creating a Scan List  39  

Scan Results  43  

Viewing Signatures ï Troublesheet  44  

Viewing Signatures Troublesheet Report  45  

Viewing Signatures ï Right Click  47  

View SigAssist Information  48  

Component Scans Information  49  

Component Scans ï Right Clicking (Auxiliary menus)  50  

Component Scans ï Right Clicking (Auxilia ry menus)  51  

Component Scans ï Right Clicking (Auxiliary menus)  52  

Sequence/Component/Pin Editing ï Right Click menus  53  

Pin Editing ï Right Clicking (Auxiliary menus )  54  

Pin Editing  55  

Adding CAD data in the Image Pane  56  

ViewPCB Image  57  

Test Creation -  Panelize  58  

Test  Creation ï Convert step 1  59  

Test Creation ï Convert step 2  60  

Test Creation ï Convert step 3  61  

Test Creation ï Convert Status  62  

Hunt ron Workstation Buttons Feature  63  

Technical Support  66  

 

 

 

 

 



© Huntron, Inc 20 12  Rev. 5 3 

Huntron Workstation Software Tutorial  

Huntron Workstation software  

It is very helpful if you have a working knowledge of Microsoft Win dows prio r to using 

Huntron Workstation.  

You are allowed to create a backup copy of the software disk. Your purchase 

agreement allows for copies to be made for backup purposes only -  copying for 

distribution or resale is strictly prohibited.   

 

Installation Instructions  

Install the software BEFORE  connecting any hardware. Uninstall any previous versions 

prior to loading the current version.  For more installation details follow the ñGetting 

Startedò sheet included with your Huntron product. 

While in Windows (2 000, XP or Vista ï 32 bit only), insert the Huntron Workstation 

CDROM. The CDROM should Autorun and display the Installation page in a browser 

window.  

 

Select Install Workstation  and follow the on -screen prompts for instructions while 

proceeding. When com plete the programs listing will have a new program group called 

ñHuntronò and an icon will be placed on the desktop. Select Install CAD Tools  if you 

have purchased additional CAD Tools. For all Prober users, you will need to install the 

NI Vision for Auto Align . Access USB Prober users will need to install the Camera  
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and Probe Tip Camera  (only certain types ï refer to the text under each link) drivers. 

Select the appropriate items from the Installation list to install these programs and 

drivers. You can vie w support documentation in PDF by clicking View Documentation  

 

Huntron Workstation Main Interface  

When starting Huntron Workstation for the first time, you will be prompted for an 

activation code. Type in the code exactly as it is presented on the installa tion CD.  

Huntron Workstation 4  has built - in conversion utilities that enable convers ion of board 

tests created in 3.X versions of Huntron Workstation.  

 

 

The Main Wi ndow for Huntron Workstation 4  features a multi -pane layout so many 

aspects of the test creation and execution can be displayed at the same time. The 

Panes are interactive to a certain degree in that changes in one Pane will affect other 

Panes. The Panes can be resized, floated independently or ñtabbedò to the sides of the 

window.  The Status Bar displays information about items currently selected and status 

information while processes are running.  

 

 

 

 

 

 

 

 

Tree Pane  
-  Test and editing  

Signature  Pane  
-  Signature display 
and scanning  

Prober  Pane  
-  Robotic Prober 
control  

Image  Pane  
-  Display of CAD 
layout and PCB 
images  

Status bar  

Tool bars  
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The Toolbar  

The Toolbar just under the application menus allows for quick access to several 

program functions. The function of each  is broken out in the diagram below.  

 

 

1.  2.  3.  4.  5.  6.  7.   8.   9.  10.   11.  12.  13.  14.  15.  16.  17.  18.  

 

1.  Create New Board database  10.  Repeat New  (Sequence, Component)  

2.  Open Board database  11.  Scan Component or Net  

3.  Save Asé 12.  Scan Sequence  

4.  Add New (Sequence, Component  or Range)  13.  Send Prober  head to  Home  position  

5.  Copy (Sequence, Component, Net  or Range )  14.  Connect/Disconnect Prober  

6.  Paste (Sequence, Component , Net or Range)  15. Previous Component or Net  

7.  Cut (Se quence, Component , Net or Range)  16.  Next Component or Net   

8.  Delete (Seq ., Comp., Net, Range or Scan)  17.  Previous  Pin 

9.  Build New (Sequence, Component)  18.  Next Pin  

 

Hardware Setup  

 

 

When first starting Huntron Workstation, select Options  from the Too ls menu. The 

Options window is used to setup default settings used when working in Huntron 
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Workstation. Select the General  tab and set the desire d Unit of Measure (use Microns  

for Huntron Access Probers, Mils  for any other Prober).  

For this tutorial, the H untron ProTrack, TrackerPXI and Tracker Model 30 will be 

referred to in general as ñTrackersò. Specific models will be mentioned by name if 

certain software features apply a specific Tracker model. The ProTrack Scanner, 

Scanner II and Scanner 31S will be r eferred to as ñScannersò. Specific models will be 

mentioned by name if certain software features apply a specific Scanner model.  

 

 

 

Select Options  from the T ools menu. Select the Hardware  tab and set the type of 

Tracker  hardware that is connected to the P C, the Tracker Port (parallel address, USB, 

etcé) and Scanner (if connected; Scanner II users should also select the number of 

Scanners connected in the ñScannersò drop menu). Access USB Probers with Tracker 

(built -in) should select ñAccess Trackerò in the Tracker menu.  

 

Prober users will need to select the type of Prober, the serial port for the Prober and 

the Frame Grabber type. To determine which COM port the Access USB (for Access 

USB Probers only) connection is using, click the Find button for Workstat ion to detect 

the Prober port. If this does not work, go to the Windows Control Panel , select 

System  and select Device Manager . Locate the Ports settings as shown in the image 

below. Use the COM number shown next to ñHS-20USBò.   
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Click the Connect  butto ns to initiate communication with the selected hardw are. Once 

connected, click the Save (Permanent)  button to save this configuration as the 

startup default.  For initial installation using a ProTrack, you will see a message that 

Loop Compensation was not f ound. A Loop Compensation file will need to be created.  

 

Using a ProTrack  

If a Loop Compensation (Loop Calc) file does not exist for the selected configuration, a 

message will appear asking that  Loop Calc be performed with  ProTrack Diagnostics.  

 

Loop Calc  needs to be run before you can use a NEW installation of the 

Huntron Workstation software  with a Huntron ProTrack .  
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-  Select Tools/Maintenance/ProTrack Diagnostics  from the menu  

Run a diagnostic routine by clicking the appropriate button in the ProTrack I 

Diagnostics window. Clicking Loop Calc  will execute the Hardware Check (except 

Scanner Test ) before running th e Loop Calc routine. The Loop Calc takes 

approximately 20 minutes to complete. Once complete, a Loop Compensation file is 

created for the selected  hardware configuration.  You will also be prompted to save a 

ProTrack configuration or ñ.PTCò file (the name will be the serial number you entered 

in the Diagnostics window). Click Yes  to save the PTC file to your PC. With newer 

ProTrack units (serial numb er prefix KJ3 or KJ4), you will be prompted by another 

window displaying ñDownload the LoopCalc settings into the ProTrack for manual 

control?ò Click Yes to download the settings. Exit Diagnostics and select 

Tools/Options/Hardware  and reinitialize the hard ware by clicking the 

Connect/Disconnect buttons.  

Other functions in the ProTrack Diagnostics allow for reading or writing the ProTrack 

configuration file. The Read from ProTrack  button will retrieve calibration and user 

settings from the ProTrack I unit an d store them as a text file on the connected 

computer  in the Program Files/Huntron/Hardware folder . It is recommended this be 

performed when setting up the system for the first time or after making changes to 

the ProTrack such as the addition of customs ra nges and range groups. The file 

generated should be stored in a safe location.  

The Write to ProTrack  button will send the calibration and user information to the 

ProTrack I unit. This can be performed if it suspected that the information stored in the 

FLASH memory of the ProTrack I has been corrupted.  

 

Using a TrackerPXI  

The TrackerPXI comes from the Factory calibrated for standalone use. If the 

TrackerPXI is connected to a Prober or other cabling, calibration must be performed.  

 

-  Select Tools/Maintenance / TrackerPXI  Diagnostics  from the menu . 

Run Calibrate  by clicking the appropriate button in the TrackerPXI  Diagnostics window. 

When the Calibrate procedure finishes (about 10 minutes), run Verify Calibration. This 

also takes about 10 minutes to complete. Th e Calibration information is stored in the 

TrackerPXI and will be used by the software. If changes are made to the cabling or 

attached instruments, simply run Calibrate and Verify Calibration again.  
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Using a Tracker Model 30  

The Tracker Model 30 comes from  the Factory calibrated for standalone use. If the 

Tracker Model 30 is connected to a Prober, Scanner or other cabling, calibration must 

be performed.  

-  Select Tools/Maintenance/ Tracker Model 30  Diagnostics  from the menu . 

Click the  Calibrate  button  the Tracker Model 30  Diagnostics window. When the 

Calibrate procedure finishes (about 10 minutes), run Verify Calibration . This also 

takes about 10 minutes to complete. The Calibration information is stored in the 

Tracker Model 30 and will be used by the softwar e. If changes are made to the cabling 

or attached instruments, simply run Calibrate and Verify Calibration again.  

 

Manual Modes ï Tracker and Scanner  

     

You may find it useful to manually test some of your components while adjusting the 

range parameter s. The two man ual modes, Tracker and Scanner located in the 

Signatures  pane, can work together to display the signature of a component pin.  

Tracker mode sets the range parameters, cha nnel and tolerance. You can also  set the 

Pulse Generator settings  (ProTra ck only) and use ALT  mode to run channel A versus 

channel B comparisons . Signatures will be displayed to the right while probing with 

hand -held probes  (select the Real - time check box) . The Hold  button will capture and 

hold t he current signature allowing fo r quick comparisons.  

Scanner m ode allows you to use a Huntron  Scanner to interface to the component 

pins. You can set the package type, number of pins and common pins. The Scan  

button starts a hands free scan of the component or you manually increment the pins 

with the <<  and >>  buttons. The Hold  button will capture and hold t he current 

signature allowing for  quick comparisons.  To store signatures you will need to create a 

Board Test .  
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Creating a Board Test  

Ther e are a number of steps necessary to creating a board test.  

 

Huntron Workstation Test Layout (Tree)

Board (creates an Access .mdb file)

Sequence (test set of components) 

Component or NET (name; e.g. U1, CR7, A0, +5V)

Pins (name, channel, etc.)

Ranges (range settings; voltage, resistance, frequency)

 

 

Example of Board Test Information:  

Board Name: Main Board (creates ñmain board.mdbò file) 

 Revision: Rev. A (This field is optional)  

Sequence: ICôs  

Component: U 27 (component name) or A2 (NET name)  

Pins: per pin settings for Scan Pin setting, channel, net name, etcé 

Ranges: Per pin settings for common reference pin, tolerance, etcé 

The user has total discretion as to the information input into these fields. There is no 

ñrightò way as to what information is entered as every userôs situation will be different. 

The above example is just one way the information might be entered.  

Entering information into the Entry windows is very straight forward. The easiest way 

to mo ve from field to field is by pressing the TAB  key. You can also use the mouse to 

click into a particular field so you can enter information.  
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Test Building Procedures  

-  Create Test Database in the Tree Pane  

o Add Board, Sequence, and Components before teachin g or scanning  

-  Scan Components and Set References (Tracker only or Tracker/Scanner users)  

-  Perform Camera Offset (Trackers/Probers users)  

-  Select Alignment points (Tracker/Prober users)  

-  Teach component pin locations (Tracker/Prober users ï teaching all points  

before scanning will save you time)  

-  Scan Sequences and Set References  

 

Listed above is a general outline on how you would proceed when preparing to test a 

board. These guidelines apply to all package types and boards. As with any type of 

complex test equi pment, practice makes perfect so take the time to learn  and practice 

these procedures.  

 

For tests created using version 3.X, Huntron Workstation has a built - in conversion 

utility. See the section on Conve rt  later in this tutorial for more information.  

 

Creating a Board Database  

 

 

To create a new Board, select New  from the File menu or use the New button in the 

toolbar. Input information into the ñAdd New Boardò dialog as needed. The only field 



© Huntron, Inc 20 12  Rev. 5 12  

that is re quired is board Name . Other fields such as Revision, System, Unit, 

Manufacturer and Gold Disk Number can be completed with related information  if 

desired . 

 

Add ing a  New Sequence  

 

 

To add a new Sequence, select the Sequence  tab in the Tree pane. Select Add  New 

Sequence  from the Edit menu or click the Add New button (+)  in the toolbar.  

Details:  

Sequence Name  Field: Enter Sequence name  

Slot  field (Prober users): Select the Prober slot that the board will be in when 

scanning.  

Compare Priority : Selects the comp arison priority between Same  (serial number), 

All  (serial numbers ; this is the recommended setting ) or Min/Max  (Merged min/max 

signatures)  

Previous / Next  buttons: Steps through existing Sequences backward or forward.  

Instructions field : Enter any instructio ns or system information that you wish to 

pass on to future users. Note: the ENTER  key in this field will work as a carriage 

return.  

The Add New , Repeat and Build  button s will allow for a nother  new Sequence to be 

created  saving the current one . 
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The Delete  button will erase the selected Sequence.  

NOTE:  Access DH users should select the Testers  tab and enable ñAccess DH ò. 

 

Other functions within this window can be read about by clicking the HELP  button.  

Component Package Types  

 

There are four different pack age types you will find yourself using when  creating 

components used in a Prober  test sequence.  The XY locations for each package type 

are ñtaughtò in slightly different ways. They are DIP  (dual - in - line), SIP  (single - in -

line), PROBE  (point by point), and MULTI  (multiple row or sided).  

 

For Tracker  with Scanner users, the package type determines how the Scanner pins 

are counted. The available Scanner packages are DIP , SIP , Both , Front , SIP2X  

(combines the A and B channels for 128 pins) and DIP2X  (combines t he A and B 

channels for 128 pins). Users of the Scanner II accessory have a DIPII  and SIPII  

package available allowing them to daisy -chain Scanners together to achieve up to 

1024 pins.  

Users of Probers and  Scanners have a MULTI - SIP  package that lets them t o probe a 

component as MULTI  package while the Scanner counts through the front connector 

as a SIP  package. This allows for selection of Common references through the 

Scanner to the Prober mounted board -under - test using a custom cable.  

 

Probers users will use the DIP, 

SIP, MULTI and PROBE 

packages.  

Tracker with Scanner users 

will use DIP  (including DIP2X) , 

SIP (including SIP2X), FRONT,  
BOTH, DIPII or SIPII  
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Add ing a  New Compon ent  

 

To add a new Component, select the Component  tab in the Tree pane. Select Add 

New Component  from the Edit menu or click Add New button ( + ) in the toolbar.  

Details:  

Component Name  field: Enter the component name (reference designator) in this 

field.  

Package  and Number of Pins  field s:  Using the mouse, click on the down arrow to 

the right of the field to bring up the pull -down menu. Select the package type and 

number of pins from the se menu s. For Access DH users  it is recommended that you 

select Number Of Pins  as 1  for 2 pin Probe package components such as resistors 

and capacitors.  

Type  field: This information is optional but you can enter the component type in this 

field.  

Pin Spacing : For prober users, you can enter the spacing between component pins in 

this field (in mils)  

Connection Type : Select the type of hardware used to interface to the component  

Open Check Type : Select from None,  Recheck or Reprobe to retest test points that 

are detected as open. Selecting Recheck will test the point with the pr obe lowered the 

distance set by Open Recheck Depth.  Reprobe will raise and lower the probe several 

times then retest. The number of ñreprobesò is set in the Tools/Options/General tab. 

Correction Steps : Sets the maximum amount of correction steps used with the 

Huntron Access Prober when moving to the first pin of the component.  
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Instructions  field: Enter any instructions or component information that you wish to 

pass on to future users.  

Other functions within this window can be read about by clicking the HEL P button.  

 

Add ing a  New Range  

When a new component is added to a Sequence the ranges used are set by the 

defaults set up in the Tools/Options/Ranges  tab. On a new software installation 

these defaults set two ranges ï 3V, 100ohms at 200Hz  and 3V, 10Kohms a t 

200Hz . In general use, these two ranges will work well but you may need to add or 

modify ranges based on component type and value. As a general reference, the table 

below can be used to assist you in setting ranges.  

 

The Tracker signatures are shaped bas ed on the Tracker range settings. The basic goal 

is to achieve signatures that are halfway between open and short. The signatures for 

the four basic types of components shown below illustrate this primary goal.  

 

 Range 

Impedance  

Voltage> 

200mV 

 

3V 

 

6V 

 

10V -15V 

 

20V 

 10  - 100  continuity, 

shorts, caps, 

resistors & 

inductors 

low 

impedance 

components 

newer MOS 

ICs 

power supply 

& regulators 

 

 1K  - 10K  resistive 

faults 

latest MOS & 

surface 

mount 

ICs 

newer MOS 

ICs 

older MOS ICs  

 20K  resistive 

faults 

resistive 

faults 

older MOS 

ICs 

TTL 74XXX  & 

74LSXXX ICs, 

older MOS Ics 

TTL 74XXX  

ICs, power 

transistor 

 100K  resistive 

faults 

resistive 

faults 

resistive 

faults 

resistive faults Hi resistance& 

Hi power 
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To add a new Range, select the  Range tab in the Tree pane. Select Add New Range  

from the Edit menu or click the Add New button ( + ) in the toolbar. A pop -up dialog will 

ask where you want the new range to be added. Select the desired radio button ( All 

Pins  is generally the desired selec tion) and click OK .  

Add New Range Details:  

Note: Voltage/Resistance/Frequency  can be modified directly in the Range grid.  

Voltage/Resistance/Frequency fields:  Select the desired range settings  

Select the Tree/Ra nge tab to display 
the ranges for the selected 
component pin. RIGHT click on the 
row header (far left grey area of the 

row) to display a quick menu (shown 
left)  

Resistance 

Capacitance 

Inductance 

Semi-conductance 
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Max Samples/Tolerance/Delay:  Select the setting to be used whe n scanning this 

range  

Common Pin :  Select Scanner common pins to be used when scanning this range . 

Scanner users wishing to use a particular component pin (i.e. ground pin) for Common 

should select the Common pin at this time using the Common Pin 1 field .  

Prober Common Pin : This allow Probers to select a Common connection  (1 -4)  

located on the front panel of the Prober.  

Note:  It is easier to set up the ranges used by selecting Tools/ Options/Range  from 

the Tools menu in the menu bar and pre - configuring the def ault ranges.  

 

Scanning with a Tracker or Tracker with Scanner  

Users of Trackers with hand probes or Scanners can now proceed with actual scanning 

of a Sequence or Component. To scan an entire Sequence, select the Sequence in the 

Tree/Sequence tab. To scan an individual component, select the component in the 

Tree/Component tab. Select the Scan tab  in the Signatures pane and input a Serial 

Number  then click the Start  button.  

 

 

 

You will be prompted to connect to the component. Tracker with Scanner  users 

sho uld connect to the selected component at this time.  Click OK  to initiate the Scan.  
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If you are performing Sequence scan you will be prompted to continue to the next 

component until all of the components in the Sequence have been scanned.  

 

 

 

If a Track er with probes  is being used your will prompted to connect to pin 1 of the 

selected component (if performing a single component scan) or of the first component 

in the Sequence (if performing a Sequence scan). Click the OK  button to scan the first 

pin. You will then be prompted to move to the next pin for scanning. Click OK  to scan 

and continue in this manner until all of the component pins are scanned. At anytime 

during scanning you can click the Previous Pin  button to go back and rescan the 

previous pin.  
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Once all pins are scanned click the OK  button to continue.  

When the Sequence or Component scan is complete the Scan Results window will be 

displayed. Go to the Scan Results  section of this tutorial for more information  on 

what to do after scanning.  

 

Prober Setup (Access DH users skip to Camera Offset for  

Access DH)  

ï Camera Offset part 1  
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Performing the Camera Offset procedure is essential for the Prober to access test 

points accurately.  

Select the Offset  tab in th e Prober pane . Make sure the Mode is set for Camera .  

Navigate the Camera to a target on the PCB  that is at least 2 inches from the Prober 

walls . A very small target that is still visible by eye works best. Use the arrow buttons 

to move the camera the dista nce set in the travel distance field (directly below the 

arrow buttons). You can also click directly in the camera image to move the camera 

crosshairs to the clicked location. This is also the best time to focus your camera. Click 

the Live  Camera  checkbox to put the camera into Live mode. Focus the camera as 

desired then uncheck the Live  Camera  mode.  

When the target is selected, press Set .  

Select Prober  in the Mode drop menu to move to the next step . 

 

Prober Setup ï Camera Offset part 2  

 

 

Lower the probe t ip down using the Z buttons until the probe just makes contact with 

the PCB . 

Visually examine the position of the probe tip; it should be located on the target 

selected in part 1 of Camera Offset, if not move on to the next step . Use a magnifying 

glass if necessary.  
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Use the XY  buttons to navigate the probe to the target selected in Part 1. The probe 

will lift when moving in the X or Y direction.  Access USB Prober users may find the 

Probe Tip Camera useful in setting the probe tip on the offset target. Selec t the Live 

Camera tab  in the Image pane then click the Select button to display the video source 

dialog. Select the correct video source and click the Start  button. A live image will 

appear in the Live Camera tab. Use the Live Camera only when needed as it  can draw 

on computer resources and slow other software processes. Use the Stop  button in the 

Video Source dialog to stop the video feed.  

When the probe is placed precisely on the target  so it is just touching , press the Set  

and Save  buttons to calculate t he Offset values.  

 

Camera Offset for Access DH  

Because the Access DH has two Z heads, setting the Camera Offset for each head is 

necessary. The procedure is very similar to the single head Prober process.  

Set the Z1 Probe head first. Select the Z1  radio bu tton in the Offset tab of the Prober 

pane. Select Camera  in the Mode field.  

 

 

 

This is a good time to focus the camera if necessary. Enable the Live Camera  

checkbox when  focus ing .   

Position the camera cross hairs on the center of your cho sen target. Press Set .  Select 

Prober in the Mode  field. The camera image will be disabled.  

 



© Huntron, Inc 20 12  Rev. 5 22  

 

The Probe head will shift  to position the probe tip over the target. Use the Z  travel 

buttons to lower the probe down to the board surface. Visually examine the position of 

the probe tip; it should be located on t he target selected earlier with the Camera , if 

not move on to the ne xt step . Use a magnifying glass if necessary.  

Use the XY  buttons to navigate the probe to the target selected earlier . The probe will 

lift when moving in the X or Y direction.  When the probe is placed precisely on the 

target  so it is just touching , press t he Set .  

Now the Z2 Prober head needs to be set. The procedure is the same as the Z1 head. 

Select the Z2  radio button.  Use the Z1 Image  button to see where the Z2 position 

should be set.  

 

 

 

Line up on your camera target and press Set . Select Prober  from th e Mode menu.  
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Lower the probe down to the board surface. Adjust the XY position if necessary using 

the XY  travel buttons. When the probe is placed properly click Set  followed by Save  to 

store the Offset values.  

Alignment for Access DH  

The Access DH requi res an additional step in the Alignment process. Each camera 

needs to be placed over a target on the board under test. Select the Align tab. Select 

Z1 Camera  from the alignment drop menu, move the Z1 camera over your selected 

target and click Set . Select Z2 Camera  and move the Z2 camera to the same target. 

Match the position as closely as possible (the Stored Image  button shows the Z1 

position) and click Set . Once complete, perform the Alignment 1 and Alignment 2 as 

described below for Access Probers.  
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Pr ober setup ï Alignment part 1  

 

 

Alignment points that are positioned in opposite corners of the board work best. If the 

test was created using CAD data, the alignment points are pre -selected and you should 

proceed to the Teach Height page.  

Select the Alig n  tab in the Prober pane . 

For best accuracy when positioning the camera on alignment points, click the Image 

Display 100%  button. This will display the camera image at full size with the best 

pixel resolution.  

Select Alignment 1  from the drop menu . 

Select and navigate the camera to the first alignment point. PCB fiducial marks, s mall 

vias or traces with 90 degree bends work well for alignment points . 

When the camera is set on the first alignment point press Set . 

The alignment point drop menu will select Ali gnment 2  automatically . 

The Auto Align  feature will use image recognition to find and automatically center on 

the alignment point. Auto Align will work only after Align is performed manually the 

first time.  
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Prober setup ï Alignment part 2  

 

 

Make sure Ali gnment 2  is selected in the Alignment point drop field . 

Select and navigate the camera to the second alignment point . 

When the camera is set on the second alignment, press the Set  button . 

 

The Auto Align  feature will use image recognition to find and autom atically center on 

the alignment point. Auto Align will only work after Align is performed manually the 

first time.  

 

Press the Save  button to store the alignment points and the alignment point images . 
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Creating a Board Image  

 

 

For Prober users, the built -in color camera can be used to create a ñmosaicò of the PCB 

by capturing images of the board and stitching them together. This is accomplished in 

the Image/Image Pane. The board must first be aligned before creating the image. 

Once aligned, you can use  any camera pane in the Prober pane to set the borders for 

image capture. We suggest using the Prober/Camera pane rather than the 

Prober/Align pane or Prober/Teach pane.  

Move the camera to the back right corner of the board . 

Press the Set Back Right  button in  the Image/Image Pane . 

Move the camera to the front left corner of the board . 

Press the Set Front Left  button in the Image/Image Pane . 

The Create Image  button should now be enabled, press to create the board image . 

 

Larger boards will require more time to create the board image. Once the board image 

is created, you can click a point on the board image and the Prober will  move the 

camera to that point. This is especially useful in Teach mode to aide in navigating the 

camera to component positions.  

Right - clic k  on the image to display a menu to Delete , Copy  or Save As  the board 

image.  
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Prober setup ï Component Teach; step 1 ( DIP package example)  

 

 

Use care when teaching component pin locations. This will ensure accurate probing. 

This example uses a DIP style p ackage to explain the Teach process. Other package 

types are executed in a very similar fashion.  

Select the Teach  tab in the Prober pane.  

Select the component to teach the Tree/Component pane . 

Select pin 1  in the Pin  drop menu . 

Navigate the camera to the first pin of the selected component (see image above) .  

When the camera is set on the first pin, press the Save  button . 

You have two XY Travel  default fields available underneath the XY travel arrow 

buttons. It can be useful to set one with a larger travel distance such as 2000 mils and 

one at a very small distance such as 1 mil.  
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Prober setup ï Component Teach; step 2  ( DIP package example)  

 

 

Navigate the camera to the last pin of the first row (see image above) .  

Set the number of pins in the row in the  Pi ns in Group  drop menu (for a DIP 

package, the number will automatically be set to half the number of pins) .  

When the camera is set on the last pin, press the Save  button by  the Pins in Group 

drop menu. This sets and calculates the positions of the remainin g pins of the first 

row.  
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Prober setup ï Component Teach; step 3 ( DIP package example)  

 

 

The pin number will automatically increment from the previous step (see above in the 

Pin drop menu).  

Navigate the camera to the first pin of the next row (s ee image above) .  

When the camera is set on the first pin of the next row, press the Save  button . 
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Prober setup ï Component Teach; step 4  ( DIP package example)  

 

 

Navigate the camera to the last pin of the row (see image above) .  

Set the number o f pins in the row in the  Pins in Group  drop menu (it will still show 

the amount selected from step 2) .  

When the camera is set on the last pin, press the Save  button by  the Group drop 

menu. This sets and calculates the positions of the remaining pins of thi s row.  

 

Teach is complete. Make sure to set the Teach Height before scanning the component . 

You can also use the Comp>  button to increment the Tree to the next component. 

This will allow you to Teach the next component without have to click in the Tree pan e.  

 

Prober Setup ï Component Teach with Access DH  

Since the Access DH has two probes, the position where each head will be located 

during scanning needs to be taught. The process is very similar to a single head 

Prober. The Z2 probe (typically the Common c onnected probe) is positioned first 

followed by the Z1 (Signal connected probe) position. In many cases the Z2 probe is 

positioned to a single point such as ground and held there while the component pins 

are scanned by the Z1 probe. The Z1 camera is used f or all component location 

teaching.  
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Select the Teach  tab in the Prober pane. Select pin 1 in the Pin  dropdown menu.  

 

 

The Z2  button should already be selected. Position the camera over the position you 

want the Z2 probe to probe when pin 1 is probed. It  may best to find a point to the 

left  of the Z1 head that will not interfere with the position of the Z1 probe. The image 

above shown a point on the ground trace being used. Click Save  to set this position. 

To keep the Z2 probe at this position while the Z 1 probe is scanning, select the highest 

number in the Pins In Group menu (16 for a 16 pin component).  

 

 

 

Click the Save  button for Pins In Group. If you wish to have the Z2 probe change 

position for each pin scanned by the Z1 head, you will need to teach each pin position 
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individually by selecting the pin number in the Pin menu, moving the camera to the 

desired position and clicking Save . Teaching the position of the Z2 probe can take 

advantage of the Pins In Group  function if you wish to speed the process  of teaching 

a row of pins. When the Z2 Teach process is complete, select the Z1.  

 

Follow the same procedure used for a single head prober from this point. Select pin 1 

from the Pin dropdown menu, position the camera over the pin and click Save .  

Move to t he end of the row of pins, select the number of pins in the row in the Pins In 

Group  dropdown menu.  

 

Click Save  to set the group and move to the beginning of the next row of pins.  
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Click the Save  button to set the beginning of the next row of pins. Move  the camera to 

the last pin of the row.  

 

Select the number of pins in the row in the Pins In Group  menu (it may already be 

correct) and click Save  to set the last row of pins.  

 

 

 

 






















































